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COPYRIGHT NOTICE 
© Copyright 1987 BAUDVILLE,. Inc. 
All Rights Reserved 

The software program, package design, and instructional 
material are reserved by BAUDVILLE. These items are in­
tended for use by the original owner only. Except for personal 
use, they may not be reproduced in any medium, or for any 
other application, without the prior written permission of 
BAUDVILLE. 

Commercial applications may require the purchase of a 
license. 

Licensing inquiries should be sent to: 

LICENSING DEPT. 
Baudville, Inc. 
1001 Medical Park Dr., S.E. 
Grand Rapids, Ml 49506 

WARNING: THIS SOFTWARE PROGRAM AND MANUAL 
ARE BOTH PROTECTED BY U.S. COPYRIGHT LAW. 
UNAUTHORIZED REPRODUCTION AND/OR SALES MAY 
RESULT IN CRIMINAL PENALTIES. COPYRIGHT IN­
FRINGERS MAY ALSO BE SUBJECT TO CIVIL LIABILITY. 

Apple and ProDOS are registered trademarks of Apple Com­
puter, Inc. 

APPLE COMPUTER, INC. MAKES NO WARRANTIES, 
EITHER EXPRESS OR IMPLIED, REGARDING THE 
ENCLOSED COMPUTER PACKAGE, ITS MERCHANTABILITY 
OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. 
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------------Introduction 

!-
Introduction 
816/Paint is a full-featured patnt program that works with all 
Apple II high resolution graphics modes; including Standard 
Hi-Res, Double Hi-Res, and the 4096 color Super Hi-Res 320 
and 640 modes. Features include full-page pictures, full­
screen painting, variable magnification zoom, and color 
animation using palette cycling. 

There are actually four paint programs in 816/Paint (one for 
each Hi-Res graphics mode). Also included is a file utility 
program that will read and write DOS 3.3 as well as ProDOS 
disks. The Standard Hi-Res and Double Hi-Res modes provide 
compatibility with the Apple lie and lie and the existing base 
of Apple II graphics. The Super Hi-Res modes access the full 
graphics capability of the Apple IIGS. 

816/Paint is extremely easy to learn and use. You will 
probably be able to accomplish a great deal without reading 
the manual. You should, however, read the manual (it's not 
long) to get the full benefit of all the program features. .~~ 

--------Equipment Required 

Equipment Required 
The Super Hi-Res graphics modes require an Apple llgs with 
at least 512K RAM available to the program. 

The Standard Hi-Res and Double Hi-Res modes require an 
Apple lie, lie, or llgs with at least 128K RAM. 

All modes require an Apple H mouse or compatible input 
device. 

816/Paint comes with two ProDOS disks; a 31/2" BOOK disk for 
the Apple IIGS, and a 51/4" disk for the Apple lie and lie. 

A printer is optional. Printers supported include the 
lmageWriter, lmageWriter II (color), and other popular printers. 
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Getting Started 
This chapter covers some basic concepts like using the 
mouse, running the programs, pull-down menus, and special 
keys. For proper equipment setup and operation, you should 
refer to the owner's manuals that came with your computer 
and printer. 

Using the Mouse 
When you move the mouse around, a small arrow, called a 
pointer or cursor, moves on the screen tracing the mouse 
movements. 

Click means press and quickly release the mouse button. 
When you want to select something on the screen, move the 
pointer to that item and click. 

Double-Click means click the mouse button twice in rapid 
succession. Double-clicking is used to select an item for some 
special or alternate action. 

Drag means hold the mouse button down while moving the 
mouse. 

Highlight means an object or menu item is displayed with a 
bright outline or inverse of its normal appearance. 

If you are not using a mouse as your input device, read 
Appendix B for instructions on alternate input devices. 

3 



Getting Started1----------

Starting up 816/Paint 
Insert the 816/Paint program disk in the drive (label facing up) 
and turn on the computer. After a few moments, the Program 
Selection Menu will appear. 

open button 
program list 

To run a program, move the pointer to the desired program 
and click to highlight the selection. Then click on the open 
button and the program will start loading. You can also use 
the arrow keys to highlight the desired program and press 
[Return] to run the program. 

If this is your first session with 816/Paint and you are using an 
Apple llgs, select Palnt.320Super. On the Apple lie or lie, 
select Paint.Dbl.Hires. 

NOTE: All of the paint programs in 816/Paint are similar in 
operation but there are some differences depending on the Hi­
Res mode. These will be noted in the manual where 
appropriate. In general, any feature marked with an asterisk(*) 
is not available in Double Hi-Res or Standard Hi-Res modes. 
If you don't see a feature on the menus, it is not available. 
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----------Getting Started 

The Paint Program Screen 
It takes a few seconds for the program to load and then the 
screen will look like this: 

color palette 

The blank space in the middle of the screen is the picture 
window, ready for drawing. As you move the cursor around 
the screen, you will notice that it changes from a pointer to 
crosshairs when inside the picture window. 

~ pointer cursor -:- crosshair cursor 

Try dragging the crosshair cursor inside the picture window 
(hold the button down while moving the mouse). As you drag, 
you will draw a line in the picture window that traces the 
mouse movements. Release the button to stop painting. 

Pull-down Menus 

The menu bar at the top of the screen provides access to 
several pull-down menus. Each word on the menu bar is the 
title of a different menu. To pull down a menu, move the 
pointer to the desired menu title and hold down the mouse 
button. The menu will appear and remain visible until you 
release the mouse button. 

-----------------------------------5 



Getting Started----------

""' 'menu bar 

highlighted menu item 

To choose a command from a pull-down menu, point to the 
menu title, hold down the mouse button, drag the pointer 
down the list until the desired command is highlighted, then 
release the button. The command will flash briefly to indicate 
that it has been selected. 

Menu commands that appear in dim type are not currently 
selectable. For example, the Cut, Copy, Paste, and Clear 
commands (in Edit menu) are available only when a region of 
the picture has been selected with the marquee or lasso tools. 

As an exercise, try clearing the picture window by selecting 
the New Picture command from th~ File menu. If you have 
changed the picture previously, you will be prompted by a 
dialog box asking if you want to save the current picture. 

yes button 

no button 

prompt 

cancel 
button 

Click the "9s button if you want to save the current picture. 
Click No to clear the picture without saving it first. Click 
Cancel to remove the dialog box and go back to the current 
picture. 

Special Keys 
Some menu commands can be selected using special key 
combinations instead of pulling down the menu with the 
mouse. These shortcut commands are selected by pressing 
the [ o ] key and a letter key simultaneously. The available 
shortcut commands are indicated by an apple symbol and a 
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----------Getting Started 

letter listed next to the menu item. 

Other keys have special uses in 816/Paint. Their use is noted 
in the manual where appropriate. 

The [ o ) Key - is called the command key, open-apple key, 
or apple key. 

The [Option) Key - On the Apple lie and lie, the closed­
apple key is the option key. 

Undo 
The Undo command in the Edit menu will undo the last 
action performed on your picture. This allows you to try things 
out before they become a permanent part of the picture. Undo 
can also be accessed by pressing the [Esc] key or the [ o] 
and [Z] keys together. Selecting undo a second time will redo 
what was just undone. 

Apple Menu 
At the left end of the menu bar is an apple symbol which 
marks the Apple menu. This menu contains the About . .. 
command and any desk accessories that may be present on 
the system disk. Choosing the About 816/Paint command will 
display a dialog box with the current program version number. 

Quitting the Program 

The Quit command will exit the program and return to the 
program selection menu. •>~ 
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Painting Tools 

Below the picture window are the various drawing tools, paint 
brushes, and a palette of colors and patterns that you will use 
to create your pictures. 

The Color Palette 
The palette of available colors and patterns is displayed at the 
very bottom of the screen. 

current 
painting 

color 

dithered 
patterns 

solid 
colors 

multi-color 
patterns 

The large box at the left end of the palette contains the 
current painting color (solid color or pattern). Anything you 
draw in the picture window will be drawn with this color. 

There are 16 solid colors at the top of the color palette (only 
8 solids in standard Hi-Res). Below the solid colors are 8 
patterns. Clicking on any solid color or pattern will highlight it 
and cause it to become the current painting color. 

The patterns are divided into two groups of 4 dithered 
patterns and 4 multi-color patterns. The dithered patterns 
are tight patterns made by mixing two solid colors. They are 
handy for creating shades in-between the available solid 
colors. To change the colors in the dithered patterns, click any 
two solid colors consecutively. The multi-color patterns can be 
changed by editing the existing patterns (see Advanced 
Techniques). 

-----------------------------------9 



Painting Tool------------

Brush Selection 
There are 12 different paintbrush shapes available. The 
current brush shape appears highlighted. To select a different 
brush, point at the desired brush and click. 

the brush set 

Entirely new brush shapes can be created by editing the 
existing ones (see Advanced Techniques). 

The Drawing Toolbox 
The icons above the color palette represent the tools used for 
drawing, painting, and manipulating objects on the picture 
window. 

To select a tool simply click on its icon. The current tool 
selection is shown highlighted. 

Freehand Sketch Tool - draws freehand lines 
using the current brush. 

Place the cursor in the picture window where you want to start 
drawing. Hold down the mouse button and draw. Release the 
button to stop drawing. 

Straight Line Tool - draws straight lines using 
the current brush 

Position the cursor where you want the line to start. Then 
drag the mouse. A straight line will stretch from the starting 
point and follow your moves. Release the button when the line 
is positioned correctly. 
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-----------Painting Tools 

Connected Lines Tool - draws connected 
straight lines, polygons, and rays using the 
current brush. 

Works just like the straight line tool. When you release the 
· mouse button after drawing the first line, a rubberband line 
will follow the cursor. Each time you click the mouse, a new 
line will be painted from the end point of the last line. Double­
click to draw the last line segment, or click outside the picture 
window to unhook the rubberband line. 

To draw rays that all connect to the starting point, hold down 
the [ o ] key when starting the first line. When you release the 
mouse button the rubberband line will stretch from the starting 
point rather than the end point of the last line. Click once for 
each ray, double-click to draw the last ray. 

Curved Line Tool - draws a smooth curve 
between two points using the current brush. 

Position the cursor at the starting point and drag a straight 
line to the ending point. Then release the mouse button and 
move the mouse around. A rubberband curve will appear 
between the end points, changing shape as you move. The 
further you move from the endpoints, the steeper the curve. 
When the curve is shaped the way you want, click to paint it 
on the picture. 

You can unhook the rubberband curve from the cursor by 
moving outside the picture window and clicking. 

French Curve Tool - draws a smooth curve 
through several points using the current brush. 

Position the cursor where you want the curve to start and 
click. Then click once at each intermediate point that you 
want the curve to pass through. Double click to mark the final 
point, or click outside the picture window. Then a smooth 
curve will be drawn through the marked points. 



Painting Tool------------

Outline Box Tool - draws a rectangular box 
outline using the current brush. 

Position the cursor at one corner of the desired box and drag. 
A rectangular outline will follow the cursor movement. Release 
the mouse button when the box is positioned correctly. 

Solid Box Tool - draws a solid rectangular box 
filled with the current color or pattern. 

Follow directions for outline box. 

Outline Oval Tool - draws the outline of an 
ellipse or circle using the current brush. 

Position the cursor at the center of the circle or elipse to be 
drawn and drag the mouse. An ellipse will follow the cursor 
movement. When you move up or down, the ellipse will be tall 
and narrow. Moving sideways will make a short, wide ellipse. 
To get a circle, move diagonally from the starting point. 
Release the mouse button when the oval is the desired size 
and shape. 

Solid Oval Tool - draw a solid oval filled with 
the current color or pattern. 

Follow directions for outline oval. 

Colorfill Tool - fill an enclosed area of the 
picture with the current color or pattern. 

Position cursor inside the area to be filled and click. All 
enclosed pixels that are the same color as the starting point 
will change to the current color or pattern. 

To fill an enclosed pattern area, first depress the [ ct J key. The 
cursor will change to an 8x8 square. Then position the cursor 
in the area to be filled and click. Any enclosed pixels that 
match the pattern in the square will be filled with the current 
color or pattern. 

The fill will leak out of an area that is not completely 
enclosed. 

12----------------

( 

( 

( 

( 

( 

( 

( 

( 

( 

( 

f 
r 
( 

( 

( 

( 

( 

( 
( 

( 

( 

( 

( 

( 

( 

( 

( 

( 

( 

( 

( 

( 

( 

( 

( 

( 

( 

( 

( 

( 



-----------Painting Tools 

Spray Paint Tool - creates an airbrush effect by 
spraying the current color or pattern onto the 
picture. 

Follow directions for freehand sketch. As you go over the 
same area, the coat of paint becomes thicker. 

Hand Tool - moves the picture page in the 
picture window. 

The picture window shows only part of the entire picture page. 
With the hand tool selected, you can press the mouse button 
to grab the picture page and drag it around in the picture 
window. 

Holding down the [Option] key while the other drawing tools 
are active will change the cursor temporarily into the hand 
tool, enabling you to move the picture without first selecting 
the hand tool icon. 

Zoom Tool - magnifies a small area of the 
picture so you can edit fine details. 

The zoom tool is special in that it works with all of the other 
drawing tools. When the zoom tool is selected, the cursor 
becomes a rectangular box inside the picture window. Move 
the rectangle to the spot you want magnified and click. Then 
the zoom window will appear on the screen. A portion of the 
unzoomed picture is visible in the view window to the left of 
the zoom window. 

view window zoom window 



Painting Tool------------

All painting is done inside the zoom window. The tools, 
brushes, and color selection work just like before. 

There are 3 different zoom magnifications. Click on 4X, 6X, or 
ax at the bottom of the zoom window to change 
magnification. Only one magnification is available in Hi-Res 
and double Hi-Res modes. 

If you move the cursor over to the picture view window, it will 
change to a rectangle. Clicking in the view window will move 
the zoom to that area of the picture. When you drag in the 
view window the zoom window will track your movement. Also, 
the picture will scroll when you hit the edge of the view 
window, making it very easy to reposition the zoom without 
using the hand tool. 

To close the zoom window, click the zoom tool icon, or click 
the small close box in the zoom window title bar. •)~ 
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Adding Text 
Text can be added to the picture at any time in a variety of 
typefaces, styles, and sizes. Clicking the Text icon activates 
the text tool. 

The Text Tool 

Text can be drawn with solid colors only. If the current color is 
a pattern, it will revert back to a solid color when you click the 
text tool. The cursor will appear as an I-beam when you move 
inside the picture window. Click on the spot where you want 
the text to begin. A flashing text prompt will replace the 
cursor. 

Type the desired text using the keyboard. Use the [Delete] key 
to backspace over mistakes. The text does not wrap 
automatically when you reach the edge of the picture window. 
You must press [Return] to move down to the next line. 

Changing Text 
Text is live and may be deleted, resized, restyled, or recolored 
until you click somewhere else in the picture window or select 
a different tool. When you click in another part of the picture 
window, the current text becomes permanent and a new line 
of text is started. 

To change the color of the current live text, click a solid color 
in the color palette. 

--------------------------------15 
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Adding Text < 
{ 

The Font, Size, and Style menus are used to change the ( 
appearance of the text. The active Font, Size, and Style ( 
selections are indicated by checkmarks on the menus. (. 
Changing one of these selections will redraw any live text. 

The font typefaces listed in the Font menu are those in the 
System/Fonts folder on the boot-up disk. The point sizes 
shown in heavy print on the Size menu will look best, 
because they are real fonts from the disk. The other sizes are 
scaled by the program. 

The Style menu changes the text styling and alignment. Align 
Left will left-justify the text. Align Middle will center the text 
around the starting point. Align Right will right-justify the text. 

Note: The Size and Style menus are not available in standard 
Hi-res and Double Hi-res modes. Only real fonts from the disk 
can be used in these modes. 

Custom Font Size* 
The last point size on the Size menu is a custom font size. To 
change this value, select the Font Size command in the 
Option menu. A dialog box will appear. 

Type any size from 1 to 99 and click the OK button .• ;~ 
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Marquee and Lasso Selections 
The marquee and lasso tools are used to select and 
manipulate images in the picture window. When an area of 
the picture is selected, it can be moved, cut, copied, or 
stretched. 

Selecting with the Marquee 

The Marquee Tool - selects a rectangular area of 
the picture. 

The marquee tool works like the outline box tool. Position the 
cursor at one corner of desired rectangle and hold down the 
mouse button. As you drag the mouse, the marquee box will 
follow. Release the mouse button when box is positioned 
correctly. The dotted marquee outline will remain on the 
picture indicating a live selection. 

When you move the cursor inside the marquee, the crosshairs 
will change to an arrow. Pressing the mouse button inside the 
marquee will grab the selection for dragging around the 
window. The image is lifted from the picture when you drag it 
to a new location. It will leave behind a clear rectangle of the 
same color as the starting point of the marquee selection box. 

------------------------------17 



Marquee and Lasso Selection~s-----

To drop a live selection on the picture, click outside the 
marquee box. This will paint the selection on the picture and 
remove the marquee. Selecting a different drawing tool will 
also drop the selection. 

Double-clicking on the marquee tool will select the entire 
picture window. Pressing the [ o ] key while starting a new 
marquee causes the rectangle to shrink to enclose only those 
pixels that are a different color from the starting point. 

Selecting with the Lasso* 

The Lasso Tool - selects free-form shaped areas 
of the picture (this tool is not available in standard 
Hi-Res and double Hi-Res modes). 

The lasso tool works like the freehand sketch tool. Drag the 
mouse to trace an outline (with the tip of the lasso) around 
the image you want to select. When you release the button, a 
straight line will connect the release point with the starting 
point, closing the region outline. 

After the mouse button is released, the lasso region will 
shrink to exclude any pixels that are the same color as the 
starting point. Then a flashing dotted outline will appear 
marking the selected object. 

If you want to select an area without shrinking, press the 
[Option] key while tracing the outline. 

Once a lasso region is selected, it can be dragged around the 
picture window just like a marquee selection. It will leave 
behind a clear region the same color as the starting point of 
the lasso selection. 

1a----------------------------
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-----Marquee and Lasso Selections 

Making Copies of Selections 
You can make a copy of a live selection by holding down the 
[Option] key when you drag the selection. A copy of the 
selection will drop on the picture each time you click on the 
selection with the [Option] key down. 

To make a trail of copies, hold down both the [Option] key and 
[ a ] key while you drag the selection. A series of multiple 
images will be left along the path you trace. The spacing 
between images will vary according to the speed you move 
the mouse. 

Stretching and Shrinking Selections* 
You can change the size of a live marquee selection by 
holding down the [ a ] key and dragging the selection. Start 
with the cursor just inside the marquee. Dragging toward the 
center of the marquee causes the selection to shrink. 
Dragging away from the center will stretch the selection. 
Holding down both the [ a ] and [Shift] keys while stretching 
will constrain movement to horizontal or vertical only. Holding 
down the [a], [Shift], and [Control] keys together while 
stretching or shrinking will force the selection to retain its 
original proportions. 

Cut, Copy, and Paste 
By using the Cut, Copy, and Paste commands in the Edit 
menu, a live selection can be cut or copied to the clipboard 
and then later pasted back on the picture or pasted in other 
pictures or programs. 

The Cut command will remove the selected image from the 
picture window and store it in the clipboard. 



Marquee and Lasso Selection-s ____ _ 

The Copy command will leave the selection on the screen 
and store a copy in the clipboard. Only one image can be 
stored in the clipboard at a time. 

The Paste command will place a copy of the clipboard image 
in the center of the picture window. The pasted image is a live 
selection that can be moved until you drop it by clicking 
outside the select region. 

If you open a new marquee in the picture window, and then 
select Paste, the clipboard image will be scaled to fit exactly 
inside the marquee. 

Other Edit Menu Commands 
The Undo command will undo the last action performed on 
your picture. Selecting undo a second time will redo what was 
just undone. 

The Clear command will erase the current selection from the 
picture (without disturbing the clipboard). The [Delete] key will 
also clear a live selection. 

The Invert command will change the color of every pixel 
inside a live selection to its complementary color. For example, 
black will change to white and vice-versa. 

The Flip Horizontal command will flip a live marquee 
selection horizontally, with the left edge of the image 
becoming the right. 

The Flip Vertical command will flip a marquee selection from 
top to bottom. 

The Rotate* command will rotate a marquee selection 90 
degrees clockwise. 

The Paintbrush* command lets you use the clipboard image 
as a paintbrush with the Freehand Sketch Tool. First, cut or 
copy an image to the clipboard. Then select the Freehand 
Sketch Icon. Finally, select the Paintbrush command. The 
clipboard image will temporarily become the current 
paintbrush. This is a one-shot command; you must select 
Paintbrush for each freehand line segment you want to draw. 
Pressing the [ o ] key and the [T] key together is a shortcut to 
the Paintbrush command .• ;~ 
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Loading, Saving, and Printing Pictures 
The File menu is used when you want to load a picture from 
the disk, save or print the current picture, or quit the program. 

Loading a Picture 
To retrieve an existing picture from disk, use the Load 
command on the File menu. A dialog box will appear with a 
list of the picture files and file folders (sub-directories) on the 
current disk. Above the list of filenames is the current disk 
pathname. You can change to a different disk by clicking the 
Disk button. 

Select a picture file by pointing at the filename and clicking to 
highlight the name. If the list of filenames is longer than will 
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Loading, Saving, & Printing1------

fit in the view box, you can scroll the list by clicking on the up 
and down arrows on the scroll bar. When the desired name is 
highlighted, click the Open button, or double-click on the 
filename to open the picture file. 

If the picture was saved in a file folder (sub-directory), you can 
open the folder in the same manner as opening a picture file. 
To return to the previous folder, click the Close button. 

Saving a Picture 
You should save your picture often while working on it. This 
will insure against losing your work accidentally. You will need 
a ProDOS formatted data disk (see File Utilities). 

When you select the Save command on the File menu, the 
save dialog box will appear. Pd. the bottom of the box are the 
picture format options. The choices are: full page size* 
(packed image), screen size (packed image), and screen size 
(unpacked binary image). The packed picture files are 
compressed to use less space on the disk. The screen size 
will save the current portion of the picture that appears when 
the Full Screen command is selected from the Option menu. 

packed file unpacked file 

Type a name for your picture in the space under Save Picture 
as ... You can use the [Delete] key to back up if you make a 
typing error. When the name is entered, click the Save button. 

You can open a folder (sub-directory) by highlighting the folder 
in the scroll box and clicking the Open button. 
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______ Loading, Saving, & Printing 
You can create a new folder by first typing a name for the 
folder and then clicking the New Folder button. 

Clicking the Cancel button will close the dialog window and 
return you to the program without saving. 

Revert 
Selecting Revert from the File menu will replace the current 
picture with the last version saved. This command will undo 
all changes made to the picture since it was last saved. 

Printing your Picture 
Use the Choose Printer command on the File menu to select 
the printer and interface options that match your equipment 
setup. Once this selection is made, it will be saved to disk 
and will not need to be changed unless you change your 
hardware. 

Use the Print command. to print the picture. A dialog box will 
appear with the printing options. Make sure the printer is 
properly connected and turned on, then click the Print button. 
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Editing the Color Palette* 
In the super hi-res modes, any solid color in the palette can 
be changed to any of 4096 possible colors. There are also 8 
separate palettes available for each picture, allowing you to 
keep 8 different color schemes for your picture or create 
special effects by cycling the palettes. 

Modifying Colors in 320 Mode* 
To modify individual colors in the palette, use the Edit Palette 
command in the Color menu, or double-click the current color 
box at the left end of the palette. The Palette Editing Window 
will appear. 

RGB sliders HSI sliders 

Pick the color you want to modify by clicking one of the 16 
solid colors in the palette, or click any spot in the picture 
window to pick colors from the picture. To move the picture 
page in the picture window, hold down the [Option] key to get 
the hand tool. 

There are two sets of slider controls that affect the current 
color. They represent two different methods of setting a color 
value. Each set can generate all 4096 colors. To adjust a 
slider control, drag the square knob in the control to the 
desired spot, or click in the control on either side of the knob. 

The controls marked H, S, and I adjust hue, saturation (white 
content), and intensity (brightness). These are similar to the 
controls on a color TV. The hue control lets you select from a 
rainbow of colors. The saturation control sets the white level of 
the color. When the saturation control is maximum (all the way 
to the right), the color will always be white or grey, no matter 
where the hue is set. The intensity control adjusts color 
brightness. When this control is set to minimum, the color will 
be black. 

-----------------------------------'>5 



Editing Palettes_*----------

The R, G, and B controls adjust the red, green, and blue 
content of the current color. There are 16 levels of red, green, 
and blue possible. All 4096 colors can be produced by mixing 
these colors. To create a bright yellow, for example, set the 
red and green sliders to maximum, and set the blue slider to 
minimum. 

It is usually easier to use the HSI controls to set the 
approximate color, and then fine tune with the RGB controls. 
Clicking the Undo button will undo the last change you made. 

Clicking the Copy button will cause the current color to be 
copied to the next color picked. If you hold down the [ a,] key 
while picking the second color, it will be swapped with the 
current color. 

Clicking the Spread button will produce a smooth range of 
colors across the palette from the current color to the next 
color picked. For example, if you pick black, click the Spread 
button, and then pick white, the result will be a smooth 
transition of grey tones across the palette from black to white. 

The Palette button will open a window where the 8 picture 
palettes can be selected and edited (see Palette Selection). 

Click OK when the palette is set the way you want, or click 
Cancel to undo all of the changes you made to the palette. 
You can restore the current palette to the standard 16 super 
hi-res colors by selecting the Std Palette command in the 
Color menu. 

Modifying Colors in 640 Mode* 
Editing the color palette in 640 mode is similar to the 320 
mode but there are some fundamental differences. The 16 
colors in 640 mode are produced by dithering a smaller set of 
colors. Individual pixels in 640 mode can be one of 4 colors 
(compared to 16 colors in 320 mode) and they are half as 
wide as the 320 mode pixels. The 640 pixels are so small that 
when you place two different color pixels side-by-side, they 
blend to from a new color. The dither is so tight that the 
colors look pure even when viewed close up. The only two 
solid colors that are not dithered in 640 mode are the ones at 
the ends of the palette (black and white). Because of 
dithering, you cannot change one of the 16 solid colors 
without affecting some of the other colors in the palette. This 
eliminates spread and copy functions in 640 mode. 
2a~~~~~~~~~~~~~~~--
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-----------Editing Palettes* 
pure colors 

The 640 mode palette editing window is slightly different from 
the 320 mode version. In the center of the window are 6 color 
boxes which are the pure pixel colors that are dithered to 
make the 16 solid colors in the palette. The reason there are 
six pure colors is related to peculiarities in the llgs video 
hardware. 

When you pick a color from the palette or picture window, one 
of the six pure colors will flash momentarily and then another 
pure color will be highlighted. These two pure colors are 
dithered to make the current color. To modify one of the six 
pure colors, click in its color box to highlight it. The slider 
controls work just like in 320 mode. Every solid color in the 
palette that contains the selected pure color will be 
underlined. Any changes you make to the pure color will 
affect the underlined palette colors. 

Palette Selection* 
To access the 8 picture palettes and color cycling controls, 
click in the Palette button when the palette editing window is 
visible. 

This is the Palette Select window. The palettes are numbered 
1 to 8. Only one palette is active at a time. The highlighted 
palette button, to the right of the number, indicates the active 
palette. To select a different palette, click the palette button or 
any color box in the desired palette. Any color in the 8 
palettes can be modified with the RGB and HSI slider 
controls. 
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Editing Palettes,_*----------

You can copy a color from any palette to another palette by 
using the Copy button. You can also copy an entire palette to 
another with the Copy button. First select the palette you want 
to copy, click the Copy button, and then click the destination 
Palette button. 

The Spread button can be used in several ways in the Palette 
Select window. You can spread horizontally between two 
colors in a single palette. You can spread vertically between 
two colors in the same column (but different palettes). If you 
pick two colors that are not in the same row or column, the 
spread will be 2-dlmenslonal, affecting all colors in the rows 
and columns inbetween. 

horizontal spread vertical 
spread 

2-dimensional 
spread 

To close the Palette Select window, click the Select button or 
the small close box at the left side of the window title bar. 

Color Cycling* 
Color animation and flashing neon sign effects can be created 
using color cycling (switching palettes at regular intervals). 
Use the Cycle Colors command in the Color menu to turn 
cycling on and off. When cycling is turned on, the picture 
palette will scroll through the selected palettes at a set speed. 
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-----------Editing Palettes* 

At the left edge of the Palette Select window are small buttons 
labeled In. When these buttons are highlighted, they indicate 
which palettes will be included in the color cycling. The speed 
at which the palettes are changed is controlled by the Cycle 
Speed control at the bottom of the Palette Select window. All 
color cycling settings are saved when you save the picture. 

Clever use of color cycling can produce some very dramatic 
effects with a minimum of effort. A good example of color 
cycling techniques can be seen in the picture named 
MODERN.GIRL on the 816/Paint program disk. Load this 
picture and select the Cycle Colors command. By examining 
the 8 palettes in this picture, you will see how spreading and 
alternating colors create different animated effects. 

Saving and Loading Palettes* 
The current picture palette can be saved to disk and reloaded 
later for use in another picture. Choose Load Palette or Save 
Palette from the Color menu. The procedure is similar to 
loading and saving picture files. Only the current palette is 
affected, the other 7 picture palettes remain unchanged .• ;~ 
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Options 
The Option menu includes commands that modify the actions 
of the various drawing tools. 

Full Screen Painting 
It is often desirable to have the entire screen available for 
painting. Choose the Full Screen command in the Option 
menu to remove the menus and tools from the screen. The 
[Space] bar or the [ o] and [F] keys are a shortcut for this 
command. The current drawing tool will still be active in the 
full screen mode. To get the menus back, press [Space] or 
press [ o] [F] again. Note when the text tool is active [Space] 
bar does not toggle the menus. 

Scroll Zoom 
The Scroll Zoom. option allows you to access the entire 
picture view window while drawing in the zoom window. When 
you reach the edge of the zoom window, it will automatically 
scroll in the direction you are moving. This allows you to draw 
or select images that are larger than the zoom window while 
zoom is active. 

Choose Scroll Zoom to implement this option (a checkmark 
next to the menu command indicates Scroll Zoom is on). 
Choose Scroll Zoom again to turn it off. 
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Mirrors 
To paint symmetrical shapes using the freehand sketch or 
straight line tools, choose Mirrors from the Option menu. The 
Mirror selection dialog will appear. 

There are four mirrors (vertical, horizontal, and two diagonal) 
represented by lines in the dialog box. You can use one or 
more mirrors at a time. Click the mirror lines that you want to 
set (indicated by a darker line). Click again to turn a mirror 
off. For each mirror that is set, any line that you draw in the 
picture window will also be drawn in a mirror reflection. 

When the desired mirrors are set, click OK to turn on the 
mirror painting. To turn off mirroring, choose Mirrors and click 
the None button. 

The center of mirror symmetry is the center of the drawing 
window. To change the center of symmetry, click the Center 
button and then click at the point in the picture window where 
you want the mirror symmetry to be centered. 

Grid 
The Grid command places an invisible grid over the picture 
window. When the grid is active (indicated by a check mark 
next to the Grid command), the drawing tools will move in 
eight pixel increments. This will help you accurately line up 
images in columns and rows. Choosing Grid before moving 
marquee or lasso selections keeps patterns aligned exactly. 
The grid does not affect the colorfill and spray paint tools. To 
turn the grid off, choose the Grid command again. .~: 
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Advanced Techniques 
Editing Patterns 
You can create custom multi-color patterns by editing the 
existing patterns. Click on the multi-color pattern you wish to 
change and then choose Edit Pattern from the Color menu, 
or simply double-click the pattern. 

This is the pattern edit window. The left side is a zoomed view 
of the pattern. Select a color from the palette and click in the 
zoomed pattern to change pixels to that color. Any changes 
you make will be shown in the normal size display at the 
right. 

You can also capture any 8x8 pixel area of the screen as a 
pattern. Point at a spot outside the palette or pattern edit 
window and click. 

Click OK to replace the original pattern with the new one. 
Click Cancel to restore the original pattern. 

Loading & Saving Patterns 
The four multi-color patterns are normally saved when you 
save the picture. You can also save these patterns separately 
by choosing Save Pattern from the Color menu. The 
procedure is the same as saving pictures. Once a set of 
patterns has been saved, you can load it with the Load 
Pattern command. 
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Advanced Technique.:,.. _______ _ 

Editing Brushes 
Any brush shape can be edited except the single-pixel brush. 
Select the brush you want to change and choose Edit Brush 
from the Option menu. 

The brush editing window has a zoomed view of the current 
brush at the left side. Click on the zoomed brush pixels to 
turn them on or off. When the brush is the shape you like, 
click OK to keep it. Click Cancel to revert back to the original 
brush shape. •)~ 
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File Utilities 
816/Paint uses ProDOS for loading and saving files. The 
816/Paint File.Utilities program allows you to format data 
disks, copy files from one disk to another (including DOS 3.3 
files), delete files, and convert pictures from one Hi-Res mode 
to another. When you run the File Utilities, a text screen 
program menu will appear. Use the arrow keys to highlight a 
menu selection and press [Return] to select. On-screen 
prompts will guide you through the program options. The [Esc] 
key will let you back out of an option. 

Formatting Data Disks 
You will need a ProDOS formatted disk for saving 816/Paint 
pictures. It is a good idea to keep several blank formatted 
disks handy to store your work. Remove the 816/Paint 
program disk from the drive, insert a new data disk to be 
formatted, and then select the Format Data Disk option. You 
will be prompted to select the drive and type a volume name 
for the disk. You will be asked if you are ready to format, 
press [Y] for yes. The disk will spin for a few moments while 
formatting. 

WARNING: Formatting a disk will destroy any files that were 
previously on it. Make sure you don't accidentally format a 
valuable data disk or the program disk. 

Copying Files 

The Copy File option will copy a file from one data disk to 
another (either ProDOS or DOS 3.3 disks). To use pictures 
that have been created with DOS 3.3 programs in 816/Paint, 
you must copy the picture files to a ProDOS data disk. 



File Utilitie------------

Deleting Files 
The Delete option will delete a file from the data disk. Be 
careful not to accidentally delete the wrong file from the disk. 
Once you delete, the file is gone. 

Converting Picture Files 
This is a very handy option that will convert a picture file from 
one Hi-Res mode to another. When you choose Convert 
Picture Files, you will have the following options: 

Standard Hi-Res to Double Hi-Res 

Standard Hi-Res to Super Hi-Res 

Double Hi-Res to Super Hi-Res 

The converted picture files are unpacked binary images. Keep 
in mind that a converted picture takes up much more disk 
space than the original. When standard and double Hi-Res 
pic~ures are converted to super Hi-Res, the resulting picture 
will be somewhat smaller than the super Hi-Res screen. Note 
that you cannot convert from higher resolution to lower 
resolution (for example, super Hi-Res to standard Hi-Res). 

320 & 640 Mode Compatibility 
Super Hi-Res pictures created in 320 mode can be used in 
640 mode and vice-versa, but there are some palette 
considerations. Pictures created in 640 mode will load in 320 
mode with the original palette colors essentially unchanged. 
Pictures created in 320 mode will load in 640 mode but the 
palette colors will not be preserved. Instead, the standard 640 
palette will be used. This is due to the dithered nature of the 
640 mode colors. Palette number 4 in the 320 mode default 
palettes has the same colors as the 640 mode standard 
palette .• ;~ 
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Shortcuts and Special Keys 
The keyboard is used extensively in 816/Paint to provide com­
mand shortcuts and enhanced program functions. Items 
marked with a single asterisks (*) are not available in the stan­
dard and double hi-res modes. Items marked with double 
asterisks (**) are not available on the Apple lie or lie. 

Keyboard Command Shortcuts 

Most menu commands can be accessed directly from the 
keyboard using the [ o] key in combination with another key. 

[ o ][1] to [BJ Select picture palette.* 

[ o ][O] Turn Color Cycling on and off.* 

[ o ][ -] Decrease color cycle speed.* 

[ o ][+] Increase color cycle speed.* 

[ o ][ < J Decrease font size.* 

[ o ][>] Increase font size.* 

[ o ][Shift][< J Change font to font previous to current font in 
font menu list.* 

[ o ][Shift][>] Change font to next font in font menu list.* 

[ o ][BJ Set text style to Bold.* 

[ o ][CJ Copy a selected image to the clipboard. 
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[ ct ][F] Turn Full Screen mode on and off. 

[ ct ][G] Turn the Grid on and off. 

[ ct ][H] Flip live marquee selection Horizontally 

[ ct ][J] Flip marquee selection Vertically 

[ ct ][K] Rotate marquee selection 90 degrees.* 

[ ct ][L] Set text style to Align Left. 

[ ct ][M] Set text style to Align Middle. 

[ ct ][N] Erase page and start a new picture. 

[ ct ][P] Set text style to Plain.* 

[ ct ][Q] Quit the program. 

[ ct ][R] Set text style to Align Right. 

[ ct ][T] Get Paintbrush from the clipboard.* 

[ ct ][U] Set text style to Underline.* 

[ ct ][V] Paste the clipboard selection to picture. 

[ ct ][X] Cut a selected image to the clipboard. 

[ ct ][Y] Invert all colors in live selection to their complimentary 
color. 

[ ct ][Z] Undo the last event. 

Special Keys 

The following keys are used in conjunction with the mouse to 
alter program functions. 

The [Option] Key 

Pressing the [Option] key while using any drawing tool (except 
marquee and lasso) changes it temporarily into the hand tool. 

Pressing the [Option] key while dragging a marquee or lasso 
selection will leave a copy of the selection. 

Pressing the [Option] key while making a lasso selection will 
select the entire region marked (no shrink wrap).* 
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------Shortcuts and Special Keys 

The [ct] Key 

Pressing the [ ct ] key while dragging inside a marquee selec­
tion will stretch or shrink the selected image.* 

Pressing the [ ct ] key while starting a marquee selection 
causes the marquee rectangle to shrink to just fit the selected 
image.* 

Pressing the [ ct] key while using the colorfill tool will fill into 
an enclosed pattern. 

Pressing the [ ct] key while using the connected lines tool will 
draw rays. 

Pressing the [ ct] key while using the Copy button in the Edit 
Palette window changes the copy function to swap.* 

The [Option] an,d [ ct ] Keys 

Pressing both the [Option) and [ct] keys while dragging a 
marquee or lasso selection will leave a trail of copies of the 
selected image.* 

The [Shift] Key** 

Pressing the [Shift] key while using the drawing tools will con­
strain movement to horizontal or vertical.** 

The [Shift] and [ct] Keys** 

Pressing both the [Shift] and ( ct ] keys while stretching a mar­
quee selection will constrain movement to horizontal or 
vertical.* 

The [Control] Key** 

Pressing the [Control] key while using the drawing tools allows 
you to change the current color by picking it directly from the 
picture.** 

The [Delete] Key 

Pressing the [Delete] key will erase a marquee or lasso 
selection. 
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The [Space) Bar 

Pressing the [Space] bar will turn Full Screen painting on and 
off (except when text tool is active). 

The [Esc) Key 

Pressing the [Esc] key is a shortcut to the Undo command. 

Double Click Shortcuts. 

Double-clicking the current color box will open the Edit Palette 
window.* 

Double-clicking the marquee or lasso icon selects the entire 
picture window.* 

Double clicking a brush icon will open the Edit Brush 
window.* 

Double clicking a multi-color pattern will open the Edit Pattern 
window .• ~~ 
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Appendix A 
Error Messages 
Occasionally you may encounter an error message while 
working with 816/Paint. These messages appear in a dialog 
box with choices to proceed or cancel the operation. 

There are two types of error messages. One type is related to 
memory allocation problems and the other is related to disk 
access problems. Most errors are recoverable but some can 
be fatal to the system. It is always good practice to save your 
work often to guard against a fatal system crash. 

One possible type of memory problem is insufficient memory 
to run the program. The Super Hi-Res modes require 512K 
minimum free RAM for the program to run. If you have set the 
RAM disk too large with the control panel, you may run into 
memory problems. 

Disk errors normally occur during loading and saving of 
pictures and other files. When a Disk 1/0 Error appears, it can 
mean the disk is not properly seated in the drive, or the drive 
is out of alignment, or the disk itself is damaged or not 
formatted. Try removing the disk from the drive and carefully 
r~_inserting. If this doesn't work, the disk may not be useable. 
it)~ 
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Appendix B 
Using Other Input Devices 
You can use other input devices with 816/Paint instead of the 
standard Apple Mouse. These include graphics tablets and 
touchpads. There are some restrictions that apply to these 
alternate devices. 

The Super Hi-Res modes require an Apple IIGS. For an input 
device to work in this mode, it must be designed specifically 
to work with the llgs and have software device drivers that are 
installed at boot-up time. These drivers can be copied to the 
816/Paint program disk. See the manual that comes with the 
device for installation instructions. 

The Standard Hi-Res and Double Hi-Res modes work on the 
lie and lie as well as the llgs. These programs have a 
confiQure option that allows you to select a different input 
device. Press both the [ct] and [Esc] keys to use the con­
figure menu. If there is not a mouse in slot 4, the configure 
menu will come up automatically. Only devices shown in the 
configure menu will work with 816/Paint. .:;~ 
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Color Palette 5, 9, 25 
Colorfill Tool 12 
Command Key (see Apple Key) 
Connected Lines Tool 11 
Constraining Movement 19, 38 
Control Key 39 
Converting Picture Files 36 
Copy 20 
Copying Picture Files 35 
Current Painting Color 9 
Cursor 3, 5 
Curved Line Tool 11 
Custom Font Size 16 
Cut 19 
Cycle Speed Control 29 



D 
Data Disks 22, 35 
Delete Key 15, 39 
Deleting Files 36 
Dialog Boxes 6 
Dithered Patterns 9 
Dithering 26 
Double-Click 3, 40 
Drag 3, 5, 6, 10, 11, 12, 13, 14, 17, 18, 19, 25 
Drawing Tools (see Tools) 

E 
Edit Brush Shape 34 
Edit Menu 7, 19, 20 
Edit Palette 25 
Edit Pattern 33 
Equipment Required 1 
Error Messages 41 
Esc Key 40 

F 
File Menu 6, 21 
File Folder 21 
File Utilities 35 
Filling Outlined Areas 12 
Flip Horizontal 20 
Flip Vertical 20 
Folder 21 
Font Menu 16 
Font Size 16 
Font Style 16 
Format Data Disk 35 
Freehand Sketch Tool 10 
French Curve Tool 11 
Full Screen Painting 31 

G 
Getting Started 3 
Grid 32 

H 
Hand Tool 13 
Highlight 3 
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------------------------------Index 
Hi-Res Graphic Modes 1, 4, 9, 16, 18, 25, 26, 35, 36, 43 
HSI (hue, saturation, intensity) 25 

Icon 10 
In Buttons 29 
Input Devices 1, 3, 43 
Invert 20 

K 
Keyboard Shortcuts 37 

L 
Lasso Tool 18 
Loading a Palette 29 
Loading Patterns 33 
Loading a Picture 21 

M 
Marquee Tool 17 
Menu Bar 5 
Menus 4, 5, 31 
Mirrors 32 
Mouse 1, 3, 43 
Moving a Selected Image 17, 18 
Multi-color Patterns 9 

N 
New Folder 22 
New Picture 6 

0 
Open 4, 21 
Open Apple Key (see Apple Key) 
Opening the Program 4 
Option Key 7, 18, 19, 38 
Option Menu 16, 31 
Outline Box Tool 12 
Outline Oval Tool 12 
Ovals 12 

p 
Page Format 22 
Paintbrush 20 
Painting Tools (see Tools) 
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lnde------------------------------
Palette 5, 9 
Palette Editing Window 

320 Mode 25 
640 Mode 27 

Palette Select Window 27 
Paste 19, 20 
Patterns 9 
Picture Window 5 
Pointer 3, 5 
Printing a Picture 23 
ProDOS 1, 35 
Program Selection 4 
Pull-down Menus 5, 6 
Pure Pixel Colors (640 mode) 

Q 
Quitting the Program 7 

R 
Rays 11 
Rectangles 12 
Revert 23 
RGB (red, green, blue) 26 
Rotate 20 

s 
Saving a Palette 29 
Saving Patterns 33 
Saving a Picture 22 
Screen Format 22 
Scroll Zoom 31 

27 

Selecting with the Lasso 18 
Selecting with the Marquee 17 
Selections 17 
Shift Key Constraint 19, 38 
Shortcuts 37 
Shrinking Selections 19 
Size Menu 16 
Slider Controls 25, 26, 27, 29 
Solid Box Tool 12 
Solid Colors 9 
Solid Oval Tool 12 
Special Effects 28, 29 
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-----------------------------Index 
Special Keys 6, 38 
Spraypaint Tool 13 
Spread Colors 26, 28 
Straight Line Tool 10 
Standard Palette (Std Palette) 26, 36 
Stretching Selections 19 
Style Menu 16 
Sub-directory 21 
Swapping Colors 26 

T 
Text 15 
Tools 9 

u 

Colorfill Tool 12 
Connected Lines Tool 11 
Curved Line Tool 11 
Freehand Sketch Tool 10 
French Curve Tool 11 
Hand Tool 13 
Lasso Tool 18 
Marquee Tool 17 
Outline Box Tool 12 
Outline Oval Tool 12 
Solid Box Tool 12 
Solid Oval Tool 12 
Spray Paint Tool 13 
Straight Line Tool 10 
Text Tool 15 
Zoom Tool 13 

Undo 7, 20 
Using the Mouse 3 

v 
Variable Font Sizes 16 
View Window 13 

z 
Zoom Tool 13-14 

Zoom Magnification 14 
Zoom Window 13 
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